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Technology Licenses
The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer 
software,” as defined by Federal Acquisition 
Regulation (“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement 

(“DFARS”) 227.7202, the U.S. government 
acquires commercial computer software 
under the same terms by which the soft-
ware is customarily provided to the public. 
Accordingly, Keysight provides the Soft-
ware to U.S. government customers under 
its standard commercial license, which is 
embodied in its End User License Agree-
ment (EULA), a copy of which can be found 
at http://www.keysight.com/find/sweula. 
The license set forth in the EULA represents 

the exclusive authority by which the U.S. 
government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require 
or permit, among other things, that Key-
sight: (1) Furnish technical information 
related to commercial computer software 
or commercial computer software docu-
mentation that is not customarily provided 
to the public; or (2) Relinquish to, or other-
wise provide, the government rights in 
excess of these rights customarily provided 
to the public to use, modify, reproduce, 
release, perform, display, or disclose com-
mercial computer software or commercial 
computer software documentation. No 
additional government requirements 
beyond those set forth in the EULA shall 
apply, except to the extent that those 
terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight 
shall be under no obligation to update, 
revise or otherwise modify the Software. 
With respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 227.7102, 
the U.S. government acquires no greater 
than Limited Rights as defined in FAR 
27.401 or DFAR 227.7103-5 (c), as appli-
cable in any technical data. 

Warranty

THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED "AS IS," AND IS 
SUBJECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, 
TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR 
IMPLIED WITH REGARD TO THIS MANUAL 
AND ANY INFORMATION CONTAINED 
HEREIN, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. KEYSIGHT SHALL 
NOT BE LIABLE FOR ERRORS OR FOR 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES IN CONNECTION WITH THE 
FURNISHING, USE, OR PERFORMANCE OF 
THIS DOCUMENT OR ANY INFORMATION 
CONTAINED HEREIN. SHOULD KEYSIGHT 
AND THE USER HAVE A SEPARATE 
WRITTEN AGREEMENT WITH WARRANTY 
TERMS COVERING THE MATERIAL IN THIS 
DOCUMENT THAT CONFLICT WITH THESE 
TERMS, THE WARRANTY TERMS IN THE 
SEPARATE AGREEMENT WILL CONTROL.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It 
calls attention to an operating proce-
dure, practice, or the like that, if not 
correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not pro-
ceed beyond a CAUTION notice until 
the indicated conditions are fully 
understood and met. 

WARNING
A WARNING notice denotes a hazard. It 
calls attention to an operating proce-
dure, practice, or the like that, if not 
correctly performed or adhered to, 
could result in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the indicated conditions 
are fully understood and met.
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consulted to gather more background information.
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N4917BSCB 400G Optical Receiver Test Application—At a Glance

Compliance Tests for Optical Transceivers

The IEEE 802.3bs, IEEE 802.3cd, and IEEE 802.3db standards define a 
series of procedures to test the correct operation of optical transceivers at 
the physical layer to ensure minimum required performance and 
interoperability (see Figure 1). Keysight solution software are available for 
each interface: Chip-to-module (C2M) interface including electrical 
transmitter and receiver tests and the optical interface with transmitter 
and receiver tests. 

Figure 1 Overview of physical layer compliance tests for a typical 400GBASE-FR8 
transceiver

In particular, the purpose of the optical receiver test is to test the receiver 
sensitivity and jitter tolerance with a stress optical signal, whose 
characteristics are defined by the standard. This stress signal is supposed 
to emulate the signal coming out of a standard-compliant transceiver after 
the worst possible optical channel.

N4917BSCB Optical Receiver Stress Test

N4917BSCB 400G Optical Receiver Test Application provides a platform 
for stressed receiver sensitivity test, which is compliant to automated 
standards for 200GBASE and 400GBASE Optical Receiver Stress Testing. 
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Additionally, the application supports compliance testing for a subset of 
100GBASE and 50GBASE standards as per the specifications. The solution 
consists of several test instruments such as a Bit Error Rate Tester (BERT), 
an arbitrary waveform generator (AWG), Digital Sampling Scope (DCA), 
Optical Reference Transmitter, Tunable Laser, and Optical Attenuator 
operating together with the N4917BSCB software package.

Salient features of the N4917BSCB 400G Optical Receiver Test Application 
include:

• Remote control of all the test instrumentation

• Automated calibration of the optical stressed eye parameters (ER, 
SECQ, and OMA) following the procedure recommended by IEEE

• Adjustable target values for ER, SECQ, and OMA

• Automated Stress Receiver Sensitivity test

• Automated jitter tolerance compliance and margin tests

Figure 2 Stress receiver conformance test according to the IEEE and corresponding 
N4917BSCB equipment configuration
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Applicable Standards

The N4917BSCB 400G Optical Receiver Test Application supports 
automated optical stressed receiver sensitivity test, based on the following 
IEEE standards:

Updated standards

The original IEEE 802.3bs/cd standards used in the N4917BSCB 
application were subsequently changed by IEEE 802.3cn, 802.3cm, and 
802.3cu standards and are now fully incorporated into the current IEEE 
802.3-2022 standard. 
You can refer to Table 1 for some of the original 802.3bs/cd calibration 
target values and Table 2 for their revised values from the IEEE 802.3cn, 
802.3cm, and 802.3cu standards.

To perform test runs using revised calibration target values from the 
updated IEEE 802.3cn, 802.3cm, and 802.3cu standards, follow the below 
steps:

1 In the Set Up tab,

• For single-mode standards at 26.5625 GBd, select Physical Layer 
50GBASE IEEE 802.3cd and Type FR.

• For multi-mode standards at 26.5625 GBd, select Physical Layer 
50/100/200/400-SR IEEE 802.3cd.

Test Name Reference Standard

200GBASE-FR4, LR4, and DR4 IEEE P802.3bs (Clauses 121 & 122)

400GBASE-FR8 and LR8 IEEE P802.3bs (Clauses 121 & 122)

400GBASE-DR4 IEEE P802.3bs (Clause 124)

400G-FR4 100G lambda MSA

100G-FR, LR 100G lambda MSA

100GBASE-DR IEEE P802.3cd (Clause 140)

50G-SR/100G-SR2/200G-SR4/400G-SR8 IEEE P802.3cd (Clause 138)

100G-SR/200G-SR2/400G-SR4 IEEE P802.3db (Clause 167)

50GBASE-FR and LR IEEE P802.3cd (Clause 139)
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• For single-mode standards at 53.125 GBd, select Physical Layer 
100GBASE IEEE P802.3cd and Type DR.

2 Go to the Configure tab and select Debug mode.

3 Refer to Table 2 and change the Transmitter Wavelength to the 
wavelength corresponding to the lane under test.

4 Expand the Stressed Receiver Signal Calibration item and then expand the 
Calibration Target Values.

5 Refer to Table 2 and edit the ER, SECQ and OMA Targets using values 
from Table 2. Optionally, edit the Initial SECQ Target. 
Note that there is no editable field for SECQ-10log(Ceq) or Transition 
Time but the default targets will be correct provided the Physical Layer 
has been chosen as detailed above in step 1.

If required, you can save this project file with new calibration target 
values by using Save Project (Settings Only) As ..feature from the 
application’s main menu and use it as template for repeat testing. 
For more information on using “Save Project (Settings Only) As..” feature, 
refer to the “Saving Test Projects” topic in the Keysight N4917BSCB 
400G Optical Receiver Test Application Online Help.

Table 1 Original 802.3bs/cd Calibration Targets

NOTE
In the current application version, only the IEEE 802.3db standard 
supports the new calibration target values listed in Table 2.

N4917BSCB supported 
stds

Original Std. Clause OER
(dB)

SECQ
(dB)

SECQ-10
log(Ceq)
(dB)

OOMA
(dBm)

Transition 
Time (ps)

200GBASE FR4 802.3bs 122 3.5 3.3 - - 3.6 -

LR4 802.3bs 122 3.5 3.4 - - 5.2 -

DR4 802.3bs 122 3.5 3.4 - - 4.1 -

400GBASE FR8 802.3bs 122 3.5 3.1 - - 3.1 -

LR8 802.3bs 122 3.5 3.3 - - 4.7 -

DR4 802.3bs 124 3.5 3.4 - - 1.9 -
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Revised calibration targets from 802.3cn, 802.3cm, 802.3cu standards are 
highlighted in Table 2.

Table 2 New Calibration Targets from 802.3cn, 802.3cm and 802.3cu

50GBASE FR 802.3cd 139 3.5 3.0 3.0 -5.3 34

LR 802.3cd 139 3.5 3.2 3.2 -6.6 34

SR 802.3cd 138 3.0 4.5 4.5 -3.4 34

100GBASE SR2 802.3cd 138 3.0 4.5 4.5 -3.4 34

200GBASE SR4 802.3cd 138 3.0 4.5 4.5 -3.4 34

100GBASE DR 802.3cd 140 3.5 3.4 3.4 -1.9 17

100GBASE SR 802.3db 167 2.5 4.4 - -2.0 17

200GBASE SR2 802.3db 167 2.5 4.4 - -2.0 17

400GBASE SR4 802.3db 167 2.5 4.4 - -2.0 17

100G FR 100G/LAMBDA MSA - 3.5 3.4 3.4 -2.5 17

LR 100G/LAMBDA MSA - 3.5 3.4 3.4 -4.1 17

400G FR4 100G/LAMBDA MSA - 3.5 3.4 3.4 -2.6 17

N4917BSCB supported 
stds

Original Std. Clause OER
(dB)

SECQ
(dB)

SECQ-10
log(Ceq)
(dB)

OOMA
(dBm)

Transition 
Time (ps)

N4917BSCB 
supported stds

Original Std. Clause Modifed 
by

OER
(dB)

SECQ
(dB)

SECQ-
10log(
Ceq)
(dB)

OOMA
(dBm)

Transition 
Time (ps)

Incorp
orated
into 
802.3-
2022

200GBASE FR4 802.3bs 122 802.3cn 3.5 3.1 3.1 - 3.8 34 Y

LR4 802.3bs 122 802.3cn 3.5 3.2 3.2 - 5.4 34 Y

ER4 802.3cn 122 6.0 3.2 3.2 -13.3 34 Y

DR4 802.3bs 122 802.3cn 3.5 3.2 3.2 - 4.3 34 Y
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400GBASE FR8 802.3bs 122 802.3cn 3.5 2.9 2.9 - 3.3 34 Y

LR8 802.3bs 122 802.3cn 3.5 3.1 3.1 - 4.9 34 Y

ER4 802.3cn 122 6.0 3.4 3.4 -14.1 34 Y

DR4 802.3bs 124 802.3cn 3.5 3.4 3.4 -1.9 17 Y

50GBASE FR 802.3cd 139 802.3cn 3.5 3.0 3.0 -5.3 34 Y

LR 802.3cd 139 802.3cn 3.5 3.2 3.2 -6.6 34 Y

ER 802.3cn 139 6.0 3.2 3.2 -13.3 34 Y

SR 802.3cd 138 802.3cn 3.0 4.5 4.5 -3.4 34 Y

100GBASE SR2 802.3cd 138 802.3cn 3.0 4.5 4.5 -3.4 34 Y

200GBASE SR4 802.3cd 138 802.3cn 3.0 4.5 4.5 -3.4 34 Y

400GBASE SR8 802.3cm 138 3.0 4.5 4.5 -3.4 34 Y

100GBASE DR 802.3cd 140 802.3cn 3.5 3.4 3.4 -1.9 17 Y

FR1 802.3cu 140 3.5 3.4 - -2.5 17 Y

LR1 802.3cu 140 3.5 3.4 - -4.1 17 Y

N4917BSCB 
supported stds

Original Std. Clause Modifed 
by

OER
(dB)

SECQ
(dB)

SECQ-
10log(
Ceq)
(dB)

OOMA
(dBm)

Transition 
Time (ps)

Incorp
orated
into 
802.3-
2022
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System Description

The N4917BSCB Test Solution for Optical Stressed Eye consists of:

• a PAM4 capable M8045A pattern generator

• an Arbitrary Waveform Generator for stress conditioning

• an electrical-optical converter that modulates the optical signal from a 
fixed or tunable laser

• a digital sampling oscilloscope for calibration of the stressed eye

• up to two M8046A error detectors and up to two N107x 
optical/electrical clock recovery. (Internal clock recovery in M8046A 
error detector module is also supported.)

• the N4917BSCB 400G Optical Receiver Test Application

For comprehensive information related to the system requirements, refer 
to Chapter 2, “Installing the N4917BSCB 400G Optical Receiver Test 
Application”.
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Contacting Keysight Technologies

For more information on products, applications or services associated with 
Keysight Technologies, contact your local Keysight office.

The complete list is available at: www.keysight.com/find/contactus.

http://www.keysight.com/main/contactInformation.jspx?tmprop=TM&cc=US&lc=eng
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As a prerequisite for installing the N4917BSCB 400G Optical Receiver Test 
Application, you require the necessary hardware and software along with 
various licenses. This chapter describes these requirements and steps for 
installing the application.
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Hardware and Software Requirements

PC Hardware Requirements

Operating system

• Microsoft Windows 7 (64 bit)

• Microsoft Windows 8 (64 bit)

• Microsoft Windows 10 (64 bit)

Memory

• 8 GB RAM [minimum]

Monitor Resolution

• WXGA+ (1440 x 900) [minimum]

PC Software Requirements

Keysight IO Libraries Suite (Software)

• Ver. 18.1

M8070B system software for M8000 series

• Ver. 9.5.560.12

M8070ADVB Advanced Measurement Package for M8000 Series

• Ver. 1.0.70.0 - Refer to Table 4 to view a list of available licenses for this 
mandatory package.

M8195A Soft Front Panel

• Ver. 4.0.0.0

M8196A Soft Front Panel

• Ver. 2.1.1.0 

N1010A FlexDCA Sampling Oscilloscope Software 

• A.07.40.319

In the newer releases of FlexDCA, analysis packages that combine many 
separate items that were available previously under individual licenses, are 
now available. Refer to the FlexDCA Data Sheet to see how features of 
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previous FlexDCA releases map into the more recent FlexDCA packages. 
For the N4917BSCB 400G Optical Receiver Test Application, you require 
the following analysis package:

• N1010100A R&D Package

Alternatively, use the older licenses:

• N1010A-9FP (PAM-N Analysis Software)

• N1010A-TFP (TDECQ Transmitter and Dispersion Eye Closure for 
PAM4)

PC Interfaces

• USB

• LAN

• GPIB (optional)

Instrument Firmware Requirements

M8040A BERT 

• M8070B System Software as specified earlier. Ensure that you install 
M8070ADVB Advanced Measurement Package for M8000 Series, as 
well. Refer to the previous section for the software version 
requirements.

86100D/N1000A DCA-X

• FlexDCA version A.07.40.319

8163B LMS

• Ver.V5.25 or later

8164B LMS

• Ver.V5.25 or later

8149xA Ref Tx

• Ver.5.01 or later
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Supported Equipment

As mentioned earlier, the N4917BSCB 400G Optical RX Test Solution 
comprises of a variety of instruments. For some of the instruments, 
alternative selections are supported. The following sections detail the 
equipment, including the minimum option requirements, which are 
compatible with the N4917BSCB Optical RX Test Solution.

BERT

• M8040A-BU2: M9505A 5-slot AXIe chassis with USB option

• M8070B-M8070ADVB Advanced Measurement Package for M8000 
Series of BERT Test Solutions. To view the list of available licenses, see 
Table 4 on page -25.

• M8045A-G32/G64*/0G3/0G4/0P3/0P6*/801 High Performance BERT 
module

• M8057A/B: Remote head for M8045A pattern generator, 1 channel

• M8046A-A32/0A4/0A5/0P3*/801 Analyzer module

Signal Generator for Sinusoidal and Gaussian Noise Interference

• M8195A-002 Arbitrary Waveform Generator or

• M8196A-002 Arbitrary Waveform Generator or

• M8054A Interference Source, 32 GHz

Lightwave Measurement System

• 8163B 2-slot lightwave multimeter 

• 8164B 5-slot lightwave measurement system mainframe

Tunable lasers 

• N7776C Tunable Laser 1240-1380 nm or

• N7778C Tunable Laser 1240-1380 nm or

• N7779C Tunable Laser 1240-1380 nm or

NOTE
An “*” (asterisk) in this section indicates options required for 
53.125Gbaud-based standards.
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• 81602A-013 Tunable Laser 1250-1370 nm or

• 81606A-113 Tunable Laser 1240-1380 nm or

• 81608A-113 Tunable Laser 1240-1380 nm or

• 81609A-113 Tunable Laser 1240-1380 nm

Reference Transmitters

• 81490A-E05 Reference Transmitter or 

• 81490A-E09 Reference Transmitter

• 81490A-E10 Reference Transmitter (multimode - for SR only)

• 81491A-085 Reference Transmitter (multimode - for SR only)

• 81491A-135 Reference Transmitter

• 81492A-E01* Reference Transmitter

• 81492A-135* Reference Transmitter

• 81000FI Optical Connector Interface

• 81000NI Optical Connector Interface

Optical attenuators: 

• 81576A Attenuator module (straight SMF) or

• 81577A Attenuator module (angled SMF) or

• N7761A external Attenuator (1 ch straight SMF) or

• N7762A external Attenuator (2 ch straight SMF) or

• N7764A external Attenuator (4 ch straight SMF)

• N7751A external Attenuator (1 ch with 2 optical power meter channels, 
SMF)

• N7752A external Attenuator (2 ch with 2 optical power meter channels, 
SMF)

• 8490D-010 - Coaxial Fixed Attenuator, DC to 50 GHz

• N7766A external Attenuator (2 ch multimode)

• N7768A external Attenuator (4 ch multimode)

DCA-X Oscilloscope

• N1000A- DCA-X mainframe with N1000A-PTB option

• N1030A/B Optical plug-in module for the N1000A DCA-X mainframe
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DCA-M Oscilloscope

• N1092A one optical channel or

• N1092B two optical channels or

• N1092C one optical, two electrical channels or

• N1092D four optical channels or

• N1092E two optical, two electrical channels

• options LOJ/PLK/IRC/200/201/300/500

Clock Recovery

• N1078A Optical/Electrical Clock Recovery

• N1077A-232/SMS/JSA Optical/Electrical Clock Recovery

• N1076A-Electrical Clock Recovery

For the complete list of available hardware options and accessories, refer 
to the Configuration Guide section in the N4917BSCB Data Sheet.
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License Requirements

The N4917BSCB Optical 400G RX Test software is a BERT compliance test 
application which requires a valid license installed in Keysight License 
Manager and an active VISA connection to an M8070B session connected 
to a M8040A 32 or 64 GBaud High-performance BERT with the module 
licenses shown below installed. Most of the required licenses have also 
been listed in the “Supported Equipment” section. For a comprehensive 
list, refer to the N4917BSCB 400G Optical Receiver Stress Test Solution - 
Data Sheet.

N4917BSCB 400G Optical Receiver Stress Test Software Configuration

Table 3 License Requirements for N4917BSCB

Product Option Description

N4917BSCB-1FP 1FP Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, node-locked, perpetual 
license

N4917BSCB-1TP 1TP Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, transportable, perpetual 
license

N4917BSCB-1NP 1NP Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, network/floating, perpetual 
license

N4917BSCB-1UP 1UP Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, USB portable, perpetual 
license

N4917BSCB-1FL 1FL Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, node-locked, 12 month 
license

N4917BSCB-1TL 1TL Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, transportable, 12 month 
license

N4917BSCB-1NL 1NL Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, network/floating, 12 month 
license

N4917BSCB-1UL 1UL Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, USB portable, 12 month 
license

N4917BSCB-1FX 1FX Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, node-locked, 24 month 
license

N4917BSCB-1TX 1TX Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, transportable, 24 month 
license
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Table 4 on page -25 shows licenses available for M8070ADVB Advanced 
Measurement Package for M8000 Series:

N4917BSCB-1NX 1NX Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, network/floating, 24 month 
license

N4917BSCB-1UX 1UX Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, USB portable, 24 month 
license

N4917BSCB-1FY 1FY Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, node-locked, 36 month 
license

N4917BSCB-1TY 1TY Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, transportable, 36 month 
license

N4917BSCB-1NY 1NY Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, network/floating, 36 month 
license

N4917BSCB-1UY 1UY Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, USB portable, 36 month 
license

N4917BSCB-1FF 1FF Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, node-locked, 6 month 
license

N4917BSCB-1TF 1TF Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, transportable, 6 month 
license

N4917BSCB-1NF 1NF Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, network/floating, 6 month 
license

N4917BSCB-1UF 1UF Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, USB portable, 6 month 
license

N4917BSCB-TRL TRL Optical Receiver Stress Test compliance app single mode 200G and 400G IEEE, USB portable, 30 days free 
trial license

M8045A G32 or G64
0G3 or UG3
0G4 or UG4
0P3 or UP3 
or 0P6 or 
UP6

32GBaud or 64GBaud PG
Jitter
Deemphasis
PAM4 32GBaud or PAM4 extension to 64GBaud

M8046A A32 or A64
0P3 or UP3

32GBaud or 64GBaud ED
PAM4 32GBaud

Product Option Description
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Table 4 Advanced Measurement Package Licenses

License Description

M8070ADVB-1FP Advanced Measurement Package for M8000 Series BERT Test Solutions, node-locked perpetual license

M8070ADVB-1TP Advanced Measurement Package for M8000 Series BERT Test Solutions, transportable perpetual license

M8070ADVB-1NP Advanced Measurement Package for M8000 Series BERT Test Solutions, floating perpetual license

M8070ADVB-1UP Advanced Measurement Package for M8000 Series BERT Test Solutions, USB portable perpetual license

M8070ADVB-1FL Advanced Measurement Package for M8000 Series BERT Test Solutions, node-locked 12 month license

M8070ADVB-1TL Advanced Measurement Package for M8000 Series BERT Test Solutions, transportable 12 month license

M8070ADVB-1NL Advanced Measurement Package for M8000 Series BERT Test Solutions, floating 12 month license

M8070ADVB-1UL Advanced Measurement Package for M8000 Series BERT Test Solutions, USB portable 12 month license

M8070ADVB-1FX Advanced Measurement Package for M8000 Series BERT Test Solutions,node-locked 24 month license

M8070ADVB-1TX Advanced Measurement Package for M8000 Series BERT Test Solutions, transportable 24 month license

M8070ADVB-1NX Advanced Measurement Package for M8000 Series BERT Test Solutions, floating 24 month license

M8070ADVB-1UX Advanced Measurement Package for M8000 Series BERT Test Solutions, USB portable 24month license

M8070ADVB-1FY Advanced Measurement Package for M8000 Series BERT Test Solutions, node-locked 36 month license

M8070ADVB-1TY Advanced Measurement Package for M8000 Series BERT Test Solutions, transportable 36 month license

M8070ADVB-1NY Advanced Measurement Package for M8000 Series BERT Test Solutions, floating 36 month license

M8070ADVB-1UY Advanced Measurement Package for M8000 Series BERT Test Solutions, USB portable 36 month license

M8070ADVB-1FF Advanced Measurement Package for M8000 Series BERT Test Solutions, node-locked 6 month license

M8070ADVB-1TF Advanced Measurement Package for M8000 Series BERT Test Solutions, transportable 6 month license

M8070ADVB-1NF Advanced Measurement Package for M8000 Series BERT Test Solutions, floating 6 month license

M8070ADVB-1UF Advanced Measurement Package for M8000 Series BERT Test Solutions, USB portable 6 month license

M8070ADVB-TRL Advanced Measurement Package for M8000 Series BERT Test Solutions, 30 days free Trial
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Table 5 on page -26 describes which of the above discussed licenses are 
mandatory for some features of the N4917BSCB application.

Table 5 N4917BSCB License Configuration

You can install the required licenses for the N4917BSCB application using 
Keysight License Manager.

License Description Description

N4917BSCB-1xx Application license Mandatory

M8080ADVB-1xx Advanced Measurement Package for M8000 
Series BERT Test Solutions 

Mandatory for the following features: 
- External CDR control 
- Jitter tolerance testing 
- DUT control interface (DCI)

M8045A-G32 32 GBd PG Mandatory

M8045A-G64 64 GBd PG Mandatory for all 53GBd based standards: 
100GBASE-DR, 100GBASE-FR, 
100GBASE-LR, 400GBASE-DR4, 
400GBASE-FR4, 100GBASE-SR, 
200GGBASE-SR2, 400GGBASE-SR4

M8045A-0G3 or UG3 Jitter Mandatory 

M8045A-0G4 or UG4 Deemphasis Mandatory 

M8045A-0P3 or UP3 PAM4 32GBd Mandatory 

M8045A-0P6 or UP6 PAM4 extension to 64 GBd Mandatory for all 53GBd based standards:
100GBASE-DR, 100GBASE-FR, 
100GBASE-LR, 400GBASE-DR4, 
400GBASE-FR4, 100GBASE-SR, 
200GBASE-SR2, 400GBASE-SR4

M8046A-A32 32 GBd ED Mandatory for receiver testing with M8046A 
error detector 

M8046A-A64 64GBd ED Mandatory for receiver testing of 53GBd 
based standards with M8046A error detector

M8046A-0P3 or UP3 PAM4 32 GBd Mandatory for ED BER measurement of PAM4 
data patterns

M8046A-0A4 or UA4 Clock Recovery for 32GBd Mandatory for ED BER measurements with 
internal clock recovery 
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Keysight License Manager

Keysight License Manager is a software utility that enables end users to 
easily manage right-to-use licenses for software and hardware capabilities 
on Keysight instruments or systems. The graphical user interface (GUI) 
gives you a visual representation of the licenses installed on your Keysight 
Technologies systems and provides access to the following features:

• View the licenses installed on a system

• Install licenses for new capabilities

• Transport licenses from one controller to another

• Borrow the licenses 

• Remove licenses for capabilities no longer needed

For detailed information on Keysight License Manager, refer to the 
Keysight License Manager Help. You can access the Keysight License 
Manager Help from the Keysight License Manager web page: 
http://www.keysight.com/find/LicenseManager

There are two versions of Keysight License Manager, which can be used to 
manage the licenses:

Keysight License Manager 6 

This license management application allows you to manage floating and 
USB portable licenses for a variety of software products and instruments.

NOTE
Please note that the Keysight License Manager 6 and Keysight License 
Manager 5 are installed on your system when you install N4917BSCB 
software.



28 Keysight N4917BSCB 400G Optical Receiver Test Application User Guide

2 Installing the N4917BSCB 400G Optical Receiver Test Application
 

You can use the Keysight License Manager 6 to configure remote license 
servers for sharing licenses across a network, or to configure a local 
license server (used with certain types of node-locked licenses) on the 
computer or instrument where your Keysight software is installed.

Although the Keysight License Manager 6 is installed on your system when 
you install the N4917BSCB software, however, you can download it from: 
Keysight License Manager 6. 

Keysight License Manager 5

This license management application allows you to manage node-locked 
and transportable licenses for a variety of software products and 
instruments.

USB portable licenses: Install, view, delete

Floating licenses: Install, view, delete, borrow, and configure license server

Node-locked licenses: Install, view, delete

Transportable licenses: Install, view, delete, and transport

https://www.keysight.com/main/redirector.jspx?action=ref&lc=eng&cc=IN&nfr=-11143.0.00&ckey=2977275&cname=EDITORIAL
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Although the Keysight License Manager 5 is installed on your system when 
you install the N4917BSCB software, however, you can download it at: 
Keysight License Manager 5. 

Installing the Licenses

Adding License using Keysight License Manager 6

Adding a Floating License

1 On the license server machine, start Keysight License Manager 6 from 
your computer's Start screen or Start menu.

2 Click Add a license to your local machine.

3 Select Add a license to this floating license server.

4 In the Add (install) a license window, click Browse... and browse to 
the location of your license file. You can repeat this as many times as 
needed to install all your licenses.

5 If you want the license server process to start automatically each time 
the server machine is restarted, make sure that Automatically start 
license server after every reboot is selected.

For more information, you can also refer the Keysight Licensing 
Administrator's Guide: 
https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf

Specify remote license servers

To tell your Keysight product where to get its floating (network) licenses, 
do the following.

1 From the Keysight License Manager 6 home screen, click Specify 
remote license server(s).

2 If you did not run License Manager from a menu in a Keysight product, 
you will see a product selection dialog box. Select the product to be 
licensed from the drop-down list.

3 In the License Setup Wizard for <Product Name> dialog box, type in 
the port_number@host_name of each server. If you have more than 
one server, separate them with semicolons ( ; ). For example:

https://www.keysight.com/main/redirector.jspx?action=ref&lc=eng&cc=IN&nfr=-11143.0.00&ckey=2225131&cname=EDITORIAL
https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf
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4 Once you've entered your server name(s), click Next to complete your 
setup.

Adding a USB License

Before adding a USB license, you must ensure that:

• Your Keysight product software is installed on this machine.

• You have a license file on this machine. If you don't have a license file, 
go to Keysight Software Manager to get one.

• If your license is locked to a dongle (USB key) rather than to a host ID:

• The dongle driver is installed on this machine. To install:

• Run Setup64.exe and accept the defaults.

• Get the FLEXID10 USB Dongle Driver from 
http://www.keysight.com/find/LicensingUsbDriver.

• Extract the .zip file to this machine.

• The dongle is connected to a USB port on this machine.

To license a Keysight product for use on this machine, select the product 
from the drop-down menu. Once you have selected your product, browse 
to the license file, then click Next to add the license.

Counted node-locked or USB portable licenses require a license server 
process: your local machine is both server and client for this license type. If 
your local machine was not already running a license server process, that 
process will be started when you click Next to complete the operation. To 
make sure the server process starts automatically each time you reboot 
the machine, ensure that Automatically start license server after every 
reboot is selected.

For more information, you can also refer the Keysight Licensing 
Administrator's Guide: 
https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf

https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf
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Adding License using Keysight License Manager 5

Adding a Node-Locked License

You can add a license to your system by installing a license (*.lic) file if you 
receive one from Keysight. 

1 Select the  > Install License File... menu option. This displays a 
Windows file selection window.

2 Use the file window to browse to and select the license file 
(<filename>.lic) that you want to add.

3 Click Open. License Manager automatically installs the license file in 
the folder and notifies you with a pop-up that the license has been 
stored in your license directory. The license now appears on the main 
license view.

For more information, you can also refer the Keysight Licensing 
Administrator's Guide: 
https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf

Transporting a License

Transportable licenses are licenses that can be moved from one host 
controller to another using the Keysight License Manager. 

1 Start the Keysight License Manager by double clicking the Keysight 
License Notifier icon or click Start > (All) Programs > Keysight 
License Manager > Keysight License Manager.

2 In the Keysight License Manager, click on Help > Keysight License 
Manager Help and perform the procedure in the Transporting 
Licenses help topic.

3 Additionally, you can also refer the Keysight Licensing Administrator's 
Guide: https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf

NOTE
Click Help > Technical Support > My Support Subscriptions to view a 
list of license subscriptions for your application.

https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf
https://literature.cdn.keysight.com/litweb/pdf/5951-5739.pdf
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Installing the Software

The installer for the N4917BSCB 400G Optical Receiver Test Application 
can be downloaded from the Keysight website.

Download the installer file from: 
https://www.keysight.com/main/techSupport.jspx?nid=-31929.1252867

To install the N4917BSCB 400G Optical Receiver Test Application, perform 
the following steps:

1 Double-click the downloaded installer file on your PC.

2 Click Run. The following screen is displayed.

Figure 3 Welcome screen

NOTE
The installer version displayed on your Welcome screen will depend on 
the version of the N4917BSCB software you have downloaded from the 
Keysight website.

https://www.keysight.com/main/techSupport.jspx?nid=-31929.1252867
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3 Click Next. The Keysight Software End-User License Agreement 
window is displayed.

4 Select Agree to agree to the license agreement and to enable the Next 
button.

Figure 4 License Agreement window
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5 Click Install. 

Figure 5 Ready to install window

6 Once the installation of the N4917BSCB 400G Optical Receiver Test 
Application begins, its status is displayed.
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7 Once the installation is complete, the following window is displayed. 
Click Finish to complete the installation and exit the wizard.

Figure 6 Window indicating end of installation
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This chapter provides an overview of the underlying concepts and features of 
the N4917BSCB 400G Optical Receiver Test Application.
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Software Concept and Flow of Optical Receiver Test

The N4917BSCB solution software controls the complete hardware 
required to perform an automated stressed signal calibration and system 
performance test in accordance with IEEE 802.3bs (clauses 121, 122, and 
124), IEEE 802.3cd (clauses 138, 139, and 140), and IEEE 802.3db (clause 
167) specifications for the following standards: 

• 200GBASE-FR4/-LR4/-DR4 (IEEE 802.3bs)

• 400GBASE-FR8/-LR8 (IEEE 802.3bs)

• 400GBASE-DR4 (IEEE 802.3bs)

• 400G-FR4 (100G per lambda MSA)

• 100G-FR/-LR (100G per lambda MSA)

• 100GBASE-DR (IEEE 802.3cd)

• 50G-SR/100G-SR2/200G-SR4/400G-SR8 (IEEE 802.3cd)

• 100G-SR/200G-SR2/400G-SR4 (IEEE 802.3db)

• 50G-FR/-LR (IEEE 802.3cd)

The software is based on a generic framework that already supports a wide 
range of automated compliance test applications for electrical 
transmission standards, such as, OIF CEI, XAUI, CAUI and many others.

The workflow of a generic compliance test application consists of five basic 
steps, which are explained in detail in Chapter 4, “Using the N4917BSCB 
Software”.

The following table briefly explains each of these steps in the workflow.

Step Description

Set Up Select standard to be tested and specify 
instrument connection settings.

Select Tests Adjust your equipment setting using Utility 
Functions and select tasks to perform from the 
list of available tests. The list of available tasks 
depends on the selected transmission standard 
and equipment configuration.

Configure Adjust specific test settings (in compliance or 
debug mode).

Connect Check the actual hardware connection with the 
provided reference diagram.
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The N4917BSCB solution software offers different measurement and 
calibration functions to perform a full 200GBASE, 400GBASE, 100GBASE, 
and 50GBASE optical receiver compliance test in accordance with IEEE 
802.3bs, 802.3cd, and 802.3db specifications. (For the list of supported 
standards, see “Applicable Standards” on page 10.)

The following flow chart explains the basic steps to perform a stressed 
optical receiver test.

Run Test Run the selected tests (either once or multiple 
times). User-defined “Tags” can be added for 
each calibration or test.

Automate Lets you construct scripts of commands that
drive execution of the application.

Results Contains more detailed information about the
tests that have been run. You can change the
thresholds at which marginal or critical warnings
appear.

HTML Report Shows a test report that can be printed.

Step Description



40 Keysight N4917BSCB 400G Optical Receiver Test Application User Guide

3 Concepts and Features of N4917BSCB Software
 

Figure 7 N4917BSCB Optical Receiver Testing Flow Chart
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Typical Setup for Optical Stress Test

The setups for stressed eye signal calibration are shown in Figure 8, Figure 
9, Figure 10, and Figure 11. The table below lists differences between 
these figures.

Figure 8 Figure 9 Figure 10 Figure 11

• Illustrates configuration 
for stressed eye 
calibration test step

• 26GBd signaling rate 
standards 

• Single mode (SM) 
configuration

• Clean clock 
configuration

• Applicable for all SM 
standards that use a 
clean clock

• Illustrates configuration 
for stressed eye 
calibration test step

• 26GBd signaling rate 
standards

• Single mode (SM) 
configuration

• Recovered clock 
configuration

• Applicable for all SM 
standards that use a 
recovered clock

• Illustrates configuration 
for stressed eye 
calibration test step

• 53GBd signaling rate 
standards (with 
additional electrical 
attenuator in 
interference signal path)

• Single mode (SM) 
configuration

• Additional electrical 
attenuator in 
interference signal path

• Clean clock 
configuration

• Applicable for all SM 
standards that use a 
clean clock

• Illustrates configuration 
for stressed eye RX DUT 
test 

• 26GBd signaling rate 
standards

• Multi mode (MM) 
configuration

• With MM optical clock 
recovery (CDR) 
configuration for RX DUT 
and BERT ED

• DCA (used for calibration 
test step) shown but not 
connected

• Applicable for all MM 
standards that use a 
recovered clock



42 Keysight N4917BSCB 400G Optical Receiver Test Application User Guide

3 Concepts and Features of N4917BSCB Software
 

Figure 8 Setup for stressed eye signal calibration for 200GBASE-FR4/-LR4/-DR4 & 
 400 GBASE-FR8/LR8 with clean clock

Note: The setup for 50GBASE-FR and 50GBASE-LR is the same as in 
Figure 8, with the exception that the tunable laser is not required; the 
internal laser source of transmitter can be used.
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Figure 9 Setup for stressed eye signal calibration for 200 GBASE-FR4/-LR4/-DR4 

& 400 GBASE-FR8/LR8 with recovered clock

Note: The setup for 50GBASE-FR and 50GBASE-LR is the same as in 
Figure 9, with the exception that the tunable laser is not required; the 
internal laser source of transmitter can be used.
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Figure 10 Setup for stressed eye signal calibration for 400GBASE-DR4 and 
  400G-FR4 (with additional electrical attenuator)

The setups for 100GBASE-DR and 100G-FR, 100G-LR is the same as in 
Figure 10, with the exception that the tunable laser is not required; the 
internal laser source of transmitter can be used.
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Figure 11 Setup for stressed eye signal calibration for 
50G-SR/100G-SR2/200G-SR4/400G-SR8/100G-SR/200G-SR2/400G-SR4
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An example setup for 200GBASE-LR4/-FR4 using four 50 Gb/s lanes on 
four wavelengths in the O-band is shown in Figure 12, which assumes the 
use of a 200 GAUI-8 electrical interface.

Figure 12 Optical receiver stress test setup for 200 GBASE-LR4/-FR4



Keysight N4917BSCB 400G Optical Receiver Test Application User Guide 47

Concepts and Features of N4917BSCB Software 3

 

Controlling N1076A/77A from M8070B System Software

For seamless integration of clock recovery in the N4917BSCB 400G 
Compliance Application, an instance of the N1076A/77A clock recovery 
must run the FlexDCA N1000-Series system software prior to starting the 
M8070B software.

Setting up the required connections involves starting the FlexDCA 
software and connecting to the CDR module(s), configuring and starting 
the SCPI server in FlexDCA, giving VISA connection to corresponding 
FlexDCA session alias name: N1076A_PROXY, and starting the M8070B 
and observing the new connection to the DCA modules. Refer to the 
Controlling N1076A/77A from M8070B topic in the Keysight M8070B 
Advanced Measurement Package User Guide to understand the procedure 
for the N1076A/77A control via M8070B and FlexDCA system software.

Figure 13 shows the block diagram depicting the recommended setup to 
connect an N1076A/77A clock data recovery module to the M8046A error 
detector module.

Figure 13 Recommended connection setup for N1076A/77A control

NOTE
N4917BSCB also supports the use of N1076B and N1078A CDR 
modules. 
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NOTE
To understand the further connection setups (supporting higher data 
rates), refer to the Keysight M8070B Advanced Measurement Package 
User Guide.
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Automated Calibration

One of the main features of the N4917BSCB solution software is the 
automated calibration of stressed receiver conformance test signal as 
specified in the IEEE specification.

The signal metrics and the calibration procedure is very similar to those of 
NRZ-based 100GBASE transmission standards (as defined in IEEE 
802.3ba) but there are noticeable differences:

• A new TDECQ/SECQ metric is employed to characterize the quality of a 
transmitted/received signal instead of the traditional eye mask 
analysis. 

• A digital reference equalizer is required to compute various signal 
metrics during transmitter performance testing or during stress signal 
calibration for receiver stress testing. 

Therefore, achieving accurate, stable and repeatable stress signal 
calibration, to ensure reliable transceiver performance test and 
qualification, has become even more challenging. Optical receiver stress 
test procedures, defined by the IEEE, are performed using several 
instruments such as a bit error ratio tester, digital sampling oscilloscope, 
optical reference transmitter and tunable laser source. The purpose of the 
test is to generate a stable and repeatable stressed optical signal with 
specific characteristics, and send it to the receiver under test to measure 
the resulting bit error ratio. However, achieving this is not a trivial task as 
the combination of different stress factors (inter symbol interference, jitter, 
sinusoidal interferences, Gaussian noise, optical power level) gives rise to 
complex dependencies on the target metrics.

Composition of IEEE 802.3bs Stressed Receiver Conformance Test Signal

The N4917BSCB software calibrates the stressed receiver conformance 
test signal according to the definitions in the IEEE 802.3 and 400G MSA’s. 
Note that you can change the target values of the metrics to be optimized 
(select Debug in the Configure tab). 

The M8045A BERT pattern generator generates a test pattern with the 
signal parameters listed in the following table. The calibration procedure 
then performs the following steps to create an impaired signal using the 
specified stress components and measuring the stress signal calibration 
metrics listed in the following table.
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Table 6 Stressed receiver compliance test signal characteristics

Transmission Standard Signal Parameter Value

200GBASE-FR4, LR4, and DR4
400GBASE-FR8 and LR8
50GBASE-FR and LR
50G/100G/200G/400G-SR

Signaling rate 
Modulation format
Calibration test pattern
Stressed receiver test pattern

26.5625 +/- 100ppm GBd
PAM4
SSPRQ (as defined in 120.5.11.2.3)
PRBS31Q (as defined in 120.5.11.2.2)

Stress Components
Sinusoidal jitter (sinusoidally jittered clock)
Sinusoidal amplitude interferer (SI)

Gaussian noise (GN)
Inter-symbol-interference (ISI)

as defined in Table 121-12
between 100 MHz - 2GHz, non-harmonic to data 
signal and other stress components
Bandwidth of at least half the signal baud rate

Stress Signal Target Metrics
Stressed eye closure (SECQ)

SECQ-10log10(Ceq)
Extinction ratio (ER)
Transition time
Stressed receiver sensitivity (OMAouter)

Stressed eye closure quaternary for PAM4 as 
defined in 121.8.10.2

as defined in 121.8.6
as defined in 121.8.9

400GBASE-DR4,
400G-FR4
100G-FR,LR
100GBASE-DR

Signaling rate 
Modulation format
Calibration test pattern
Stressed receiver test pattern

53.125 +/- 100ppm GBd
PAM4
SSPRQ
PRBS31Q

Stress Components
Sinusoidal jitter (sinusoidally jittered clock)
Sinusoidal amplitude interferer (SI)
Gaussian noise (GN)
Inter-symbol-interference (ISI)

Same as for the other supported 400GBASE and 
200GBASE standards

Stress Signal Target Metrics
Stressed eye closure (SECQ)

SECQ-10log10(Ceq)
Extinction ratio (ER)
Transition time
Stressed receiver sensitivity (OMAouter)

Stressed eye closure quaternary for PAM4 as 
defined in 124.8.10
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1 The pattern generator output amplitude is adjusted so that the clean 
eye signal (i.e., sinusoidal jitter, sinusoidal interferer and Gaussian 
noise turned off) has approximately the minimum extinction ratio as 
specified in the standard.

2 The N4917BSCB software stress signal calibration offers an automated 
procedure that adjusts the initial SECQ value by means of changing the 
BERT deemphasis coefficients to emulate the ISI resulting from the 
frequency response of an E/O converter. ISI calibration Method 3 uses 
some improved readjustment algorithms and should give the best ISI 
calibration results for all transmission standards; Keysight 
recommends using it for the initial SECQ adjustment.

3 After turning on the sinusoidal jitter (SJ), sinusoidal interferer (SI) and 
Gaussian noise (GN), the software changes iteratively the amplitudes 
of the stress components until all stressed signal metrics are met.

4 The parameters of the stressed receiver test signal are stored in a 
calibration file to be recalled for the same setup at a later point in time.

The stressed receiver conformance test signal as defined in the IEEE 
standard allows certain degrees of freedom to meet the specified target 
metrics SECQ, ER and OMAouter. For example, the frequencies of 
sinusoidal jitter and sinusoidal amplitude interferer are not exactly 

100G/200G/400G-SR Signaling rate 
Modulation format
Calibration test pattern
Stressed receiver test pattern

53.125 +/- 100ppm GBd
PAM4
SSPRQ
PRBS31Q

Stress Components
Sinusoidal jitter (sinusoidally jittered clock)
Sinusoidal amplitude interferer (SI)
Gaussian noise (GN)
Inter-symbol-interference (ISI)

Stress Signal Target Metrics
Stressed eye closure (SECQ)
Extinction ratio (ER)
Transition time
Stressed receiver sensitivity (OMAouter)

Transmission Standard Signal Parameter Value

NOTE
ISI generation Method 3 is now the default method for all transmission 
standards.
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specified by the standard but can be set in the given range (see Table 
121-12). Also, the ratio between sinusoidal interferer and Gaussian noise is 
not specified in the IEEE 802.3bs standard but may be specified by the 
user. 

The N4917BSCB software also offers to change these parameters by using 
the calibration configuration variables (explained in Chapter 5, 
“Performing Stressed Receiver Compliance Tests with N4917BSCB 
Software”).

• Periodic Jitter Frequency (default: 119.2 MHz)

• Sinusoidal Interferer Frequency (default: 1.9431 GHz)

• Sinusoidal Interferer to Noise Ratio (default: 10 dB)

• Initial SECQ (default ~half of target SECQ)

Figure 28 depicts the N4917BSCB software stress signal calibration 
procedure.

Support for transmission standards compliant with IEEE 802.3cd or IEEE 802.3db 
specification – Comparison with original IEEE 802.3bs standard

The IEEE 802.3cd or IEEE 802.3db standard introduces a number of 
changes for the stressed receiver sensitivity (SRS) testing compared to the 
previous IEEE 802.3bs standard. The definitions can be found in IEEE 
802.3cd clauses 138, 139, and 140 or in IEEE 802.3db clause 167 and 
affect the following new transmission standards:

• 100GBASE-DR

• 50GBASE-FR, 50GBASE-LR

• 50G/100G/200G/400G-SR (Multi-mode)

• 100G-SR/200G-SR2/400G-SR4 (IEEE 802.3db)

• 400G-FR4 MSA (specification updated to comply with IEEE 802.3cd)

• 100G-FR MSA, 100G-LR MSA

Some of these changes are:

• New Stressed receiver condition SECQ – 10log10(Ceq)

The coefficent Ceq was already introduced in IEEE 802.3bs (121.8.5.3) 
and describes the noise enhancement factor for the reference (TDECQ) 
filter. According to the new cd standard, the Ceq coefficient must be at 
least 1 or larger (i.e. 10*log10(Ceq) >= 0). The N4917BSCB software 
uses a modified initial SECQ optimization procedure (see configuration 
variable “ISI generation method”), which. ensures that Ceq is larger 
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than the specified value (“Ceq target value”) before noise is added to 
the signal. 

• RINxx.xOMA parameter condition (not measured in current revision)

While the RINxx.xOMA parameter was already defined in the IEEE 
802.3bs as transmit characteristic, the IEEE 802.3cd standard adds it 
as a new requirement during SRS testing stating that the RINxx.xOMA 
should not exceed the value specified in the corresponding transmit 
characteristic when the Gaussian noise generator is turned on and the 
sinusoidal jitter and sinusoidal interferer are turned off (clause 
140.7.10). 

This means the RINxx.xOMA can be controlled by the SI to GN ratio 
(see configuration variable “Sinusoidal Interferer to Noise Ratio”) and 
the user has to increase the SI/GN ratio, if necessary, to meet the 
RINxx.xOMA condition.

• Rx sensitivity (not stressed) dependent on Tx SECQ

Contrary to the IEEE 802.3bs standard, the receiver sensitivity (not 
stressed) is not defined by a single OMA value but dependent on the 
transmitter SECQ used to measure the receiver sensitivity.

• New multimode standards 

The PAM4 multimode standards (-SR/SR2/SR4) defined in the IEEE 
802.cd/db are not based on the 100GBASE-SR4 recommendations 
(clause 95) but have the following main differences:

• Clean clock (instead of recovered clock)

• No jitter calibration
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Automated Compliance and Performance Tests

The automated compliance and performance tests use nearly the same 
setup as used for the stressed receiver signal calibration. The difference is 
that the optical fiber from the attenuator output is connected to the optical 
input of the receiver/lane under test instead of the input of the DCA. You 
can use an optical switch to swap the connections. This optical switch can 
be controlled using the Auxiliary Instrument VISA Address and Auxiliary 
Instrument SCPI Command variables under the Configure tab.

The optical receiver is stressed with the calibrated compliance test signal 
on the lane under test and the received bit error rate (BER) is measured 
and compared against the target value under various conditions. Note that 
all the other optical lanes are supposed to be activated to serve as optical 
cross-talk source. A possible realization of such requirement is illustrated 
in Figure 12.

Different approaches to recover the BER are supported:

• The BER can be retrieved from the transceiver internal error counter – if 
any. In this case the communication between the device under test and 
the N4917SCB solution software is realized using the DCI interface of 
the M807B software.

• If no internal error counter is available on the transceiver, an M8046A 
error detector should be employed to measure the BER of the lane 
under test. The clock signal used for the error detector should be 
extracted from the recovered signal (either provided by the DUT or 
extracted from another lane using an external CDR. Using the internal 
clock recovery in the new M8046A error detector module is also an 
option).

The following tests can be performed automatically:

• Rx Compliance Test: measures the Rx BER compliance at the stressed 
receiver sensitivity (OMAouter) as defined in the IEEE standards.

• Jitter Compliance Test: measures the Rx BER compliance at different 
jitter frequencies with maximum jitter amplitude as defined in IEEE 
802.3bs Table 121-12, IEEE 802.3cd Table 138-13, and IEEE 802.3db 
Table 167-13.

• Rx Sensitivity Measurement: measures the Rx BER versus stressed 
receiver sensitivity (OMAouter). 

• Jitter Performance Measurement: measures the Rx BER versus jitter 
frequency and amplitude.
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Table 7 Stressed receiver compliance target metric

Transmission Standard Signal Parameter Value

200GBASE-FR4, LR4, and DR4
400GBASE-FR8, LR8, and DR4
400G-FR4
100G-FR and LR
100GBASE-DR
50G-SR/100G-SR2/200G-SR4/400G-SR8
100G-SR/200G-SR2/400G-SR4
50GBASE-FR and LR

Target error ratio 2.4e-4
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As a prerequisite for using the N4917BSCB software, ensure that all the 
required instruments specified in “Supported Equipment” on page 20 are 
defined in the Keysight Connection Expert on the PC, where the Keysight 
N4917BSCB 400G Optical Receiver Test Application is installed.
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Starting the N4917BSCB 400G Optical Receiver Test Application

The N4917BSCB 400G Optical Receiver Test Application is available to be 
run as a standalone application on a PC, and either connecting locally or 
remotely to the hardware setup.

Before you launch the N4917BSCB 400G Optical Receiver Test 
Application, make sure that the following software are running and online:

• FlexDCA N1000-Series System Software for connecting to all the 
available DCA and CDR modules (used for stressed receiver compliance 
signal calibration)

• M8195A/M8196A/M8054A soft front panel software (used to control 
the sinusoidal interferer and Gaussian noise signal generator). For 
M8054A Interference Source, see "Using M8054A Interference 
Source" on page 59.

• Keysight M8070B software to connect to M8040A High-performance 
BERT, which, in turn tries to connect to the FlexDCA using an available 
“N1076A_PROXY”.

Ensure that proper connections with the testing instruments are 
established. Ensure that the measurement instruments are connected on 
the same LAN as the remote PC, where the N4917BSCB 400G Optical 
Receiver Test Application is installed.

NOTE
It is recommended to start the various software tools in the following 
order to make sure all the connected instruments are recognized and 
initialized correctly:

1. Start FlexDCA software and configure CDR modules (optional)

2. Start AWG soft front panel. For M8054A Interference Source, see 
"Using M8054A Interference Source" on page 59.

3. Start M8070B system software with option /IgnoreAWG
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Using M8054A Interference Source

The M8054A Interference Source must be used in an almost identical way 
as the M8195A and M8196A AWG modules. However, there are some 
differences. Perform the following steps:

1 Connect M8045A pattern generator TRIG OUT to M8054A REF CLK IN 
(similar to M8195A and M8196A).

2 Start the M8070B system software with the “/IgnoreAWG” option. 
Either use the command line to start the M8070B software in this 
manner or add this option as a new startup option from the M8070B 
Startup Options dialog.

3 Start the M8054A soft front panel (SFP) separately and manually.

a Since there is no entry to start the M8054A SFP from the Windows 
Start menu, navigate to “C:\Program Files (x86)\Keysight\M8054\
bin\” and start the executable: “AgM8054SFP.exe”. For subsequent 
use, consider adding a shortcut on the desktop to be able to start 
the SFP.

NOTE
As opposed to M8195A and M8196A, the N4917BSCB ORST application 
must run on the same machine as the M8054A SFP (which, in turn must 
run on the machine connected to the AXI mainframe where the M8054A 
is installed). Also, the M8054A SFP does not need to be installed 
manually by the user but will automatically be installed with the latest 
M8070B software.
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The M8054A does not show any GUI elements to control the IF 
source (i.e., the SFP window is mostly empty)

b Get the VISA address of the M8054A Interference Source by 
selecting Help > About.

4 Use the VISA address of M8054A SFP for Sinusoidal and Gaussian 
Noise signal generator in N4917BSCB software.
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To access the N4917BSCB 400G Optical Receiver Test Application, 
perform the following steps:

1 From the Start menu of the Windows 7 or 8 Operating System, select 
All Programs > Keysight M8070B Applications > Keysight N4917BSCB > 
Launch Keysight N4917BSCB.
On Windows 10 Operating System, select Keysight M8070B Applications 
> Launch Keysight N4917BSCB

Figure 14 Launching the N4917BSCB Rx Test Application on Windows 10

Alternatively, type N4917BSCB in the Windows Search box to locate the 
application.

NOTE
If you do not see the required entries on the Start menu, the N4917BSCB 
400G Optical Receiver Test Application has not yet been installed on the 
PC.

Refer to “Installing the Software” on page 32 for installation instructions.
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• If you are launching the Keysight N4917BSCB 400G Optical Receiver 
Test Application for the first time, the End-User License Agreement 
window appears. Select Agree to continue.

• The N4917BSCB 400G Optical Receiver Test Application banner is 
displayed.

• If there is a single instance of the M8070B software running locally, the 
N4917BSCB 400G Optical Receiver Test Application launches after 
automatically getting connected to the M8070B software. 

• If the N4917BSCB 400G Optical Receiver Test Application does not 
detect any instance of the M8070B software running locally, the 
Connect to M8070 window appears.

Figure 15 Connecting to M8070B

2 Perform one of the following actions:

• In the Enter/Select VISA address/alias (or SICL address): text field, 
you can either type or copy the VISA/SICL address directly from the 
Keysight M8070B Software and paste it here. To verify the correct VISA 
address to connect to M8070B, access the SCPI Server Information 
window. by clicking Utilities > SCPI Server Information... from the 
main menu of the Keysight M8070B software.
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Figure 16 SCPI Server Information window on the M8070B Software

• If the BERT device is online and defined in the Keysight Connection 
Expert, click Select from Keysight Connection Expert favorites:. The 
VISA address list defined in the Keysight Connection Expert software for 
each online instrument is displayed. After you verify the VISA/SICL 
address, select the correct VISA Address from the list.

3 Click Get on the Connect to M8070 window. The IDN: field displays the 
instrument name.

Figure 17 IDN field displaying successful connection to M8070B

4 Click OK to establish connection with M8070B and to launch the 
N4917BSCB 400G Optical Receiver Test Application. If the connection 
cannot be established, the application start will be aborted. If the 
required licenses are missing, a message is displayed.
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5 When the application starts successfully it will start with the default 
layout and will show the Set Up tab.

Figure 18 Default view of the N4917BSCB 400G Optical Receiver Stress Test  
Application

For more information on how to use the various features in the 
N4917BSCB 400G Optical Receiver Test Application, refer to the Keysight 
N4917BSCB 400G Optical Receiver Test Application Online Help.

NOTE
The Message tab will show info, warning and error messages while 
running the N4917BSCB application as well as intermediate results of 
measurements. Scroll up and down to display relevant messages.

NOTE
The application framework enables you to use docking and floating 
windows, so the GUI can be customized to meet your requirements. If 
you want to reset the GUI to its default layout, select View > Reset > Tab 
Layout in the application menu.
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Setup tab - Setting up the N4917BSCB 400G Optical Receiver Test Application

Before you start any stressed signal calibrations or receiver testing with the 
N4917BSCB application, you must set up the application first.

Figure 19 Setting up the N4917BSCB Optical Receiver Stress Test BERT Compliance 
Application

Under the Set Up tab,

1 In the Optical Standard area,

i Select one out of these options - 200GBASE IEEE 802.3bs, 
400GBASE IEEE 802.3bs, 400G-FR4 100G Lambda MSA 
Group, 100G-FR/LR 100G Lambda MSA Group, 
100GBASE-DR IEEE P802.3cd, 50G/100G/200G/400G-SR 
IEEE 802.3cd, 100G/200G/400G-SR IEEE 802.3db or 
50GBASE IEEE 802.3cd in the Physical Layer area, to indicate 
the physical medium attachment (PMA) sublayer type on which 
the calibrations/tests are to be performed. The Select Tests 
tab displays the respective calibrations and tests. By default, 
200GBASE IEEE 802.3bs is selected.

ii Select the physical medium dependent (PMD) sublayer. The 
following table displays the available PMD sublayers for the 
physical layer standards:
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iii Specify the lane under test for the selected optical standard 
and type. The transmission lane refers to the center 
transmission wavelength for a wavelength-division-multiplexed 
physical layer type. Hence the number of available lanes might 
vary between selected transmission standards. DR and SR 
sublayer types do not have lanes assignments but use multiple 
fiber pairs for transmission and will show “n/a” instead. Similar 
is the case for 100G-FR and 100G-LR sublayer types that are 
based on 100GBASE-DR standard.

2 In the Instrument Setup area, specify the VISA/SICL address for the 
following instruments:

• BERT Pattern Generator

• Error Detector Module

• DCA

• Sinusoidal Interference Generator

• Gaussian Noise Generator

• Tunable Laser Source

• Reference Transmitter

• Optical Attenuator

Physical Layer Type

200GBASE IEEE 802.3bs FR4, LR4, DR4

400GBASE IEEE 802.3bs FR8, LR8, DR4

400G-FR4 100G Lambda MSA Group FR4

100G-FR/LR 100G Lambda MSA Group FR, LR

100GBASE-DR IEEE P802.3cd DR

50G/100G/200G/400G-SR IEEE 802.3cd SR/SR2/SR4/SR8

100G/200G/400G-SR IEEE 802.3db SR/SR2/SR4

50GBASE IEEE 802.3cd FR, LR

NOTE
In the FlexDCA software, go to Tools-> SCPI Programming Tools-> SCPI 
server to activate the SCPI server or retrieve its information.
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i Click Select... corresponding to the above instruments to 
connect to them using the SICL/VISA address, if not connected 
already. By default, when you start the N4917BSCB 400G 
Optical Receiver Test Application, a connection dialog is 
displayed to connect at least to the BERT device, else the 
application fails to launch. A green LED indicates that the 
instrument has been connected successfully.

ii Select an appropriate module, channel, or slot, wherever 
appropriate.

iii Click Check Connections to verify that the instruments are 
properly connected to the N4917BSCB 400G Optical Receiver 

NOTE
In the M819xA soft front panel, go to Help-> About to find the AWG SCPI 
server address.

For connecting to M8054A Interference Source, refer to "Using M8054A 
Interference Source" on page 59.

NOTE
The Tunable Laser Source can be ignored if the internal laser source of 
the reference transmitter is used. In this case, the exact emission 
wavelength must be specified in the “Transmitter Wavelength” 
configuration variable under the Configure tab. For more information, see 
"Connecting to the Internal Laser Source of the Reference Transmitter" on 
page 68.

NOTE
N4917BSCB supports the usage of up to two error detector modules 
(ED) to make combined BER measurements on multiple DUT output 
lines. If more than one ED is found, an additional entry for the combined 
modules will be shown in the drop-down list (for example, for detected 
error detector modules M2 and M3, combined module “M2+M3” is 
shown.)



68 Keysight N4917BSCB 400G Optical Receiver Test Application User Guide

4 Using the N4917BSCB Software
 

Test Application.

3 In the Test Report Comments (Optional) area, enter appropriate 
values in the Device Identifier:, Device User Description: and 
Comments: text fields, respectively, such that they appear in the HTML 
Report that is generated after test runs. Performing this step is 
optional. However, Keysight recommends entering these values to 
identify the test results for the corresponding DUT when there are large 
number of DUTs to be tested.

Connecting to the Internal Laser Source of the Reference Transmitter

The internal laser source of the reference transmitter can be used instead 
of the tunable laser source. Perform the following steps:

1 If a TLS is available and has been connected in the test application, set 
the slot selector to "not used". If no TLS is available or the test 
application has not been connected to it yet, leave slot selector at 
"n/a".

2 Provide the exact laser wavelength of the internal reference transmitter 
source in the “Transmitter Wavelength” configuration variable under 
the Configure tab.

3 Connect the optical laser output of the reference transmitter to the 
optical modulator input.

NOTE
Some instruments might be a module in a multi-module mainframe (e.g. 
tunable laser source as module in Keysight’s 8164B Lightwave 
Measurement System) and thus shares the same VISA address as other 
instruments in that mainframe. Select the appropriate module, channel 
or slot to connect to these instruments. A message in the logging tab 
might give more information about the model code of the connected 
module.
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Select Tests tab – Select test and measurement task to be performed

The Select Tests tab is the main area in the N4917BSCB where tests can 
be selected to be performed during the next Run command. Each test is 
part of a test group which can be expanded or collapsed by clicking on the 
preceding arrow. The info area below the test tree shows additional 
information about the selected test.

Figure 20 Select Tests tab
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NOTE
All selected tests will be performed successively (from top to bottom of 
list) during the next Run command. If a certain test needs be performed 
before other tests (e.g. optimization of BERT deemphasis), please run this 
test separately with all other tests deactivated. In the current release, the 
Optimize BERT deemphasis test can be configured to run automatically 
before Stressed receiver signal calibration using the “Optimize 
deemphasis on calibration start” configuration parameter.

NOTE
When activating/deactivating a test group, all child tests will be 
activated/deactivated accordingly.
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Configure tab – Configure application and test specific settings

The Configure tab lists all user configuration variables available for the 
selected transmission standard and sublayer. The configuration variables 
are subdivided into the same groups as the test structure and can likewise 
be expanded or collapsed by clicking on the small preceding arrow. The 
groups of configuration variables are further divided into logical 
subgroups. For example, the Stressed receiver signal calibration group 
contains some variables and subgroups called Sequence Control, 
Connection Settings, Calibration Target Values and Stress Signal 
Parameters. Likewise, the Receiver Testing group contains some variables 
and BERT Settings, Jitter Measurement Settings, and RX Sensitivity 
Measurement subgroups.

Figure 21 Configure tab
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The current value of a variable is show in parentheses behind the variable 
name. To change a value, select an existing value from the corresponding 
drop down box or type in a new one.

The information text below the drop box shows additional information 
about the configuration variable, for example, its minimum or maximum 
value as well as its precision (only applicable for numeric types)

The N4917BSCB compliance test application offers two configuration 
modes:

• Compliance mode and Debug mode

In Compliance mode, specific user variables which represent specifications 
cannot be edited. To allow changing these values (thus deviating from the 
standard), switch to Debug mode.

Connect tab – Display hardware connection diagrams and test specific information 

The Connect tab displays hardware connection diagrams before the start 
of a test. This optional step allows the user to check the physical 
connections between the devices to ensure compliance with the 
standards.

Run tab – Run selected tests or measurements

The Run tab defines various settings to run tests and starts the selected 
tests or the automation script created in the Automate tab. The 
user-defined “Tags” can be added for each calibration or test.

Automate tab – Run automated scripts

The Automate tab starts any automation scripts created in the Test 
Application.

Results & HTML Report tabs – Display test results

The Results tab and the HTML Report tab display the high-level and 
detailed test and measurement results. Some tests return only a pass/fail 
value and others return detailed measurement results (such as, scalar 
values, tables or images captured from an Oscilloscope’s display).
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The N4917BSCB 400G Optical Receiver Test Application also facilitates 
exporting the measurement results and HTML reports into CSV, PDF files 
or even to a Web Dataset Repository. For a detailed understanding of the 
functionality of each tab and various features within the N4917BSCB 400G 
Optical Receiver Test Application, refer to the Keysight N4917BSCB 400G 
Optical Receiver Test Application Online Help.

NOTE
The functionality of the Upload Results to Repository feature is not fully 
supported in the current version of the N4917BSCB 400G Optical 
Receiver Test Application.
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Technical Support

Check the Help menu for various user assistance documents. For technical 
support, contact Keysight Technical Support (Help > Technical Support > 
Contact Technical Support) or your Keysight representative. When 
reporting a software crash, go to Help > Technical Support > Collect 
Files. Send the zip file to your Keysight Technical Support representative.
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This section describes the calibration and test procedures in the 
N4917BSCB 400G Optical Receiver Test Application that correspond to 
the applicable IEEE standard.
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Setting Up and Preparing the Compliance Test Setup

Before launching the N4917BSCB Optical Receiver Stress Test software 
and performing an optical receiver compliance test you need to set up the 
required instruments and make the physical connections shown in Figure 
22. To ensure stable operation, observe the specified warm up times of the 
instruments being used. Also ensure that the BERT M8070B System 
software, the DCA N1010A FlexDCA software, and the M8195A/M8196A 
Soft Front Panel software are running. Refer to the Note below on the 
order of starting the software.

Figure 22 Equipment connections for IEEE802.3bs/cd calibrations and tests

NOTE
The required system software must be started in the following order:
1. DCA N1010A FlexDCA software
2. M8195A/M8196A/M8054A Soft Front Panel software
3. M8070B System software
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Configure global test settings

After selecting the transmission standard in the Set Up tab, the 
N4917BSCB software loads the corresponding test limit file (check also: 
Tools-> Compliance limits -> Activate/Refresh limit set) and sets the 
respective configuration variables in the Configure tab. All global test 
settings, such as the signal baud rate, transmission wavelength or the 
BERT deemphasis tap values are listed in the root group (see Figure 23). 
Please note that some value cannot be changed in Compliance mode but 
only in Debug mode.

Figure 23 Global configuration variables
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Calibrating the stressed receiver conformance test signal

The normative requirement for optical receivers to be compliant according 
to the IEEE 802.3bs/cd/db standards is the stressed receiver sensitivity, 
which is measured with the methods defined in IEEE 802.3bs section 
121.8.9 using the conformance test signal described in section 121.8.9.2, 
in IEEE 802.3cd sections 138.8.10, 139.7.10, and 140.7.10, and in IEEE 
802.3db section 167.8.14 for the relevant standards.

The N4917BSCB compliance test solution offers a fully automated 
calibration procedure to generate this compliance test signal which is then 
used to perform the stressed receiver sensitivity measurement and 
determine the receiver compliance.

Figure 24 Unavailable tests due to missing instrument connections

Optimizing the BERT deemphasis

Running the automated conformance test signal calibration requires an 
optimized BERT output that compensates the non-ideal frequency 
response on the signal path due to amplifiers and E/O converter. 

Hence, it is recommended to run an automated BERT deemphasis 
optimization prior to the stressed receiver conformance test signal 
calibration. By default, running the “Auto-calibration of stressed eye 
signal” automatically performs a BERT deemphasis optimization prior to 
starting the actual calibration procedure. This feature can be disabled by 
changing the value of the “Optimize deemphasis on calibration start" 
configuration variable to false. Alternatively, the BERT deemphasis 
optimization can be performed separately by running the “Optimize BERT 
deemphasis” test from the Utility functions.

NOTE
To run the automated calibration from the test tree (Select tests tab), all 
instruments in the Set Up tab needs to be connected and configured 
successfully, otherwise one or more tests will be unavailable.
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The BERT deemphasis optimization procedure generates a PAM4 test 
pattern and determines the optimum 4 tap (2 pre-cursor, 1 post-cursor) 
deemphasis coefficients. After successfully running the test, the 
measurement result is reported in the Results tab (applies only when 
running it as a separate test from the Utility functions) and automatically 
set as active values in the corresponding configuration variable (BERT 
deemphasis taps in main group).

Figure 25 Exemplary BERT deemphasis optimization result when running the test 
from the Utility functions

Configuring calibration specific settings

The calibration specific configuration variables such as the calibration data 
pattern and the calibration target metrics can be found in the Stressed 
Receiver Signal Calibration settings. Figure 26 shows the exemplary 
calibration settings for the 400GBASE-FR8 transmission standard. The 
Stressed Receiver Signal Calibration settings are logically grouped in the 
following categories:

• General variables (These do not have an associated category name.)

• Sequence Control

• Connection Settings

• Calibration Target Values

• Stress Signal Parameters

Highlighted in blue are generic configuration settings which control the 
overall behavior of the calibration procedure. The Sequence Control and 
Connection Settings subgroups are the next groups displaying the relevant 
parameters for optimizations and clock-related settings.

Highlighted in yellow are the calibration target values (according to IEEE 
802.3bs standard) and the corresponding calibration tolerances.

• Transmitter TX Extinction ratio (ER)

• ER Calibration Tolerance
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• Target Stressed Eye Closure (SECQ)

• SECQ Calibration Tolerance

• Target Receiver Power (OMAouter)

• OMAouter Calibration Tolerance

• Initial SECQ Target

• Initial SECQ Target Tolerance

Shown in green are the stress ccomponent settings (sinusoidal jitter and 
sinusoidal interferer frequency) to be used for the calibration.

Figure 26 Exemplary stressed receiver signal calibration configuration variables for 
400GBASE-FR8
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Figure 27 Placement of RF Attenuator

NOTE
To ensure the optimum measurement results, it is recommended to 
activate the Perform dark level calibration feature. This feature checks 
the DCA channel calibration status prior to each test and triggers a 
recalibration, if required.

NOTE
A Dark Current Calibration triggered without switching off the light at the 
optical input port might result in invalid sampling scope calibration. An 
error message similar to 11, “Instrument Error; Channel Nx Offset is set 
to limit: Entry was out of range" might be reported.

In this case, navigate to the FlexDCA menu option Tools > Calibrations to 
clear and recalibrate the DCA module. Ensure that the optical sampling 
scope (DCA) gets recalibrated on a regular basis.

NOTE
Due to the limited output voltage range (75mV to 1V) of the used AWG 
modules (M8195A or M8196A) as interference source, the use of an 
additional RF attenuator in the interference signal (SI + GN) path is 
required in specific hardware configurations. These include the use of 
IEEE 802.3cd transmission standards in combination with the new 
81492A-E01 reference transmitter or the 81491A-085 multimode 
transmitter. In these or other cases, when the N4917BSCB application 
aborts the stress signal calibration with an error message indicating that 
the AWG voltage has been clipped to its lower range, insert an RF 
attenuator (6dB or 10dB) in the interference signal path as shown in 
Figure 27.
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The flowchart below depicts the N4917BSCB software stress signal 
calibration procedure.

Figure 28 Stress signal calibration procedure
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Configuring TDECQ presets in FlexDCA

Occasionally TDECQ preset names in a FlexDCA release are updated or 
renamed, usually when a standard moves from draft to final. As a result, 
the default configuration settings of the N4917BSCB compliance test 
application may request a TDECQ preset that is no longer available in the 
FlexDCA software.
In this release, the test application fails to load the TDECQ Filter Preset 
value while running the stressed eye signal calibration for the IEEE 802.3 
dB optical standard and aborts the calibration.

For the successful completion of the stressed eye calibration for the IEEE 
802.3 dB standard, please follow the below steps to create/save new 
TDECQ settings in the FlexDCA:

1 From the FlexDCA main menu, click Measure > Waveform Signal 
Processing (Math). The Waveform Signal Processing Setup window is 
displayed.

Figure 29 Waveform Signal Processing Setup window

2 From the operators categories shown in the top-left corner of the 
window, click Signal Processing. The TDECQ operator is displayed.

Figure 30 Signal Processing - TDECQ operator
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3 To configure TDECQ presets, drag TDECQ operator into the window's 
operator's palette.

Figure 31 TDECQ operator dragged into the window’s operator palette

4 Now, click on TDECQ operator. The TDECQ Reference Equalizer Setup 
window is displayed. By default, Reference Rx tab is selected.

Figure 32 TDECQ Reference Equalizer Setup window 

5 In the Reference Rx tab, first select the IEEE 802.3db/D2.0 SR (844-863 nm) 
preset, then uncheck the Apply Modal Dispersion Filter check box. To 
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save these settings as a new preset value, click + button next to the 
Preset field. The Enter a name for this new preset window is displayed.

Figure 33 Enter a name for this new preset window

6 Enter preset name as IEEE 802.3db/D2.0 SR SECQ and click OK. The new 
preset name displays in the Preset field. 
Make sure all the settings agree with the screen shot below i.e. 
Automatic Taps checked, Auto Precursors checked, Taps per UI = 1, 
Number of Taps = 9, Max Precursors = 3.

Figure 34 Preset field with IEEE802.3db/D2.0 SR SECQ preset
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7 Next, go to TDECQ Measurement tab, then select the IEEE 802.3db/D2.0 
preset, then to save these settings, click + button next to the Preset 
field and add the same preset name as added under Reference Rx tab in 
step 6. 
Make sure all the settings agree with the screen shot below i.e. Target 
SER = 4.80E-4, Histogram Width = 0.04 UI, Optimize Histogram Times 
is checked, Histogram Spacing = 0.10 UI, Adjustment Limit = 1.00 UI, 
OMA/ER Definition Minimum Zero Level Run = 6 and Minimum Three 
Level Run = 7, Threshold Optimization Enable is checked and 
Adjustment Limit = 2.0%.

Figure 35 TDECQ Measurement tab with IEEE 802.3db/D2.0 SR SECQ preset

8 Once, you have configured the same TDECQ preset value IEEE 
802.3db/D2.0 SR SECQ in both the Reference Rx and TDECQ Measurement 
tab, launch the N4917BSCB compliance application. 

9 To use the new TDECQ preset, within the N4917BSCB application, 
follow the steps below:

a Under the Set Up tab, select the 100G/200G/400G-SR IEEE 802.3db 
Optical Standard option.

b Select the Configure tab, and change to Debug mode.

c Expand the Stressed Receiver Signal Calibration item, then expand the 
Stress Signal Parameters item.
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d Click the TDECQ Filter Preset item and in the right pane type the name 
of the new preset i.e. IEEE 802.3db/D2.0 SR SECQ and press enter.

Figure 36 Manually selecting TDECQ Filter Preset in Debug mode

Starting the stressed receiver conformance test signal calibration

To start the actual stressed receiver conformance test signal calibration, 
activate the corresponding check box in the test tree and click the Run 
button on the Run tab or right-click in the test tree and select Run 
checked tests.

During the calibration, status messages in the message window show the 
progress of the run and display the currently performed action and 
intermediate measurement results.

NOTE
The automated stress signal calibration will reset and reconfigure all 
used hardware instruments at the beginning of each calibration run. 
Hence any manual settings will be lost. So, make sure to save these 
settings prior to starting a calibration run.

NOTE
The automated stress signal calibration might take several minutes 
(more than 20 min), depending on the used hardware and calibration 
settings. In case the calibration aborts during the run due to a timeout 
error, please try to increase the instrument timeout variable in global 
settings in the Configuration tab.
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NOTE
The running calibration process can be aborted by clicking the Stop 
button on the Run tab.

NOTE
The intrinsic SECQ must be lower than initial target SECQ. Therefore, 
BERT de-emphasis optimization is recommended before each 
calibration.

Calibration step Class Relevant configuration variables Access Default value

Instrument Initializations

BERT

Baud Rate Debug Mode 26.5625 GBaud
(53.125 GBaud for 
400GBASE-DR4, 400G-FR4, 
100GBASE-DR, 100G-FR, 
100G-LR, 100G-SR, 200G-SR2, 
400G-SR4)

Calibration Pattern Debug Mode SSPRQ

Optimize deemphasis on calibration 
start

TRUE

BERT Deemphasis 0.0,0.0,1.0,0.0,0.0

DCA

Use SIRC Reference Filter Debug Mode TRUE

SIRC 3dB Filter Bandwidth 13.28126 GHz
(26.5626 GHz for 400GBASE-DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, and 100G-SR, 
200G-SR2, 400G-SR4)

Set Display Mode Stacked

Perform Dark Level Calibration TRUE

TLS Transmitter Wavelength Set by standard

ATT

Stressed Eye Calibration Power Mode Max

Stressed Eye Calibration Power 3 dBm

Set Attenuator Control State FALSE

Initial ER Optimization

REFTX Operating Point 
Optimization
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After successful completion of the calibration run, the calibration results 
are reported in the Results tab.

The calibration results include the following measurements:

• Currently used BERT deemphasis taps

• Measured NRZ crossing points (from reference transmitter operating 
point optimization)

• Measured PAM4 linearity

• Measured clean eye SECQ (ISI only) (“initial SECQ)

• Measured calibration target metrics

PAM4 Linearity Optimization

Clean Eye Measurement

Generate Stressed Eye Signal

SJ Periodic Jitter Frequency 119.2 MHz

Periodic Jitter Amplitude 0.05 UI

SI Sinusoidal Interferer Frequency 1.9431 GHz

GN Sinusoidal Interferer to Gaussian 
Noise Ratio

10 dB

DCA TDECQ Filter Preset Debug Mode Standard Definition

Ceq target value 0.2 dB
(Applicable for IEEE 
802.3cd-based flavors)

ISI generation method Method 3 (default for all 
transmission standards)

TDECQ Equalization Filter 
Optimization

DCA Use TDECQ Filter Optimization 
Feature

TRUE

Stressed Eye Parameter 
Optimization

Target TX Extinction Ratio (ER) Set by standard

ER Calibration Tolerance 0.1 dB

Target Stressed Eye Closure (SECQ) Set by standard

SECQ Calibration Tolerance 0.1 dB

Target Receiver Power (OMAouter) Set by standard

OMAouter Calibration Tolerance 0.1 dB

Calibration step Class Relevant configuration variables Access Default value
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• Screenshot of stressed receiver test signal (without TDECQ filter / with 
TDECQ filter)

Figure 37 Calibration results

Calibration tasks

Auto calibration of stressed eye signal

Overview This calibration automatically adjusts the stress parameters (ER, SECQ, 
OMA) for a 200G, 400G, 100G or 50G stressed eye signal.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID
Type Test ID

200GBASE FR4 1000

200GBASE LR4 2000

200GBASE DR4 3000

400GBASE FR8 4000

400GBASE LR8 5000

400GBASE DR4 6000

400G-FR4 7000

100G-FR 14000

100G-LR 15000
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Configuration Parameters You may modify the following parameters for this calibration:

• Stress Signal Calibration Pattern (SSPRQ)

• Stress Signal Recall Pattern

• Stressed Eye Calibration Power Mode (Max)

• Stressed Eye Calibration Power

• Use SIRC Reference Filter

• SIRC 3dB Filter Bandwidth

Sequence control values

• Optimize deemphasis on calibration start

• Perform Dark Level Configuration

• Optimize PAM4 Linearity

• Initial SECQ Optimization

• Use TDECQ Filter Optimization Feature

• Calibration Iteration Limit

• Skip receive power (OOMA) calibration

Connection Settings

• DCA Clock Source

• Clock Data Recovery Module

• Clock Data Recovery Loop Bandwidth

• PG ClockOut Divider

Calibration target values

• Target TX Extinction Ratio (ER)

• ER Calibration Tolerance

• Target Stressed Eye Closure (SECQ)

• SECQ Calibration Tolerance

• Target Receiver Power (OMAouter)

100GBASE-DR 8000

50G-SR/100G-SR2/200G-SR4/400G-SR8 9000

100G-SR/200G-SR2/400G-SR4 16000

50G FR 12000

50G LR 13000

Type Test ID
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• OMAouter Calibration Tolerance

• Initial SECQ Target

• Initial SECQ Target Tolerance

Stress signal parameters

• Periodic Jitter Frequency

• Periodic Jitter Amplitude

• Sinusoidal Interferer Frequency

• Sinusoidal Interference (SI) attenuator

• SI channel attenuation value

• Gaussian noise (GN) attenuator

• GN channel attenuation value

• Sinusoidal Interferer to Noise Ratio

• TDECQ Filter Preset

• Ceq target value (applicable only for IEEE 802.3cd and IEEE 802.3db 
based flavors)

• ISI generation method

Procedure Refer to “Automated Calibration” on page 49.

Results Pass/Fail

Recall stressed eye signal from last calibration settings

Overview This task recalls and applies the latest stressed eye calibration settings.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID
Type Test ID

200GBASE FR4 1004

200GBASE LR4 2004

200GBASE DR4 3004

400GBASE FR8 4004

400GBASE LR8 5004

400GBASE DR4 6004

400G-FR4 7004
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Configuration Parameters

Procedure Refer to “Automated Calibration” on page 49.

Results Pass/Fail

100G-FR 14004

100G-LR 15004

100GBASE-DR 8000

50G-SR/100G-SR2/200G-SR4/400G-SR8 9004

100G-SR/200G-SR2/400G-SR4 16004

50G FR 12004

50G LR 13004

Type Test ID
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Testing the stressed DUT receiver compliance

As introduced in “Automated Compliance and Performance Tests” on page 
54, the N4917BSCB software offers four automated receiver test 
procedures divided into the two groups - Conformance Tests and 
Performance Tests. All the receiver tests imply a calibrated and compliant 
stress test signal to be connected to the optical lane under test of the 
receiver under test, whereas the stress test signal can be either recalled 
from a previous calibration setting file (default) or is assumed to be already 
running from a previous test.

Configuring receiver tests settings

Depending on the used test setup, different hardware configurations as 
well as test specific settings must be made prior to starting a receiver test. 
Figure 38 shows all the receiver test related configuration variables, which 
have been divided in several sub-groups. The calibration related variables 
have been highlighted in yellow; the variables highlighted in pink are 
hardware-related settings that apply to all the receiver tests, whereas the 
configuration variables highlighted in blue control the behavior of specific 
receiver tests.
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Figure 38 Configuration variables for receiver testing

Compensation of optical loss in receiver test path

To ensure compliant receiver testing, the automated test procedure must 
compensate for any additional loss in the receiver test path (see Figure 39 
for a schematic of stressed receiver optical path loss definitions). Since the 
calibration procedure can only measure the common loss in the optical 
path, any additional loss in the receiver test path must be measured 
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manually by the user and provided as dB value (positive numbers 
represent a loss, negative numbers a gain) in the “Additional System Loss” 
configuration variable (default is 0dB).

Figure 39 Stressed receiver optical path loss definitions

The flowcharts on the following pages depict the receiver test procedures 
available in the N4917BSCB software.

NOTE
A full receiver compliance test might require other optical stress signals 
(“aggressor lanes”) to be connected to the other lanes of the receiver 
under test. For further information, check specification of the 
corresponding IEEE standard.
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Figure 40 Receiver conformance test procedure
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Figure 41 Receiver jitter tolerance tests procedure
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Figure 42 Receiver sensitivity measurement test procedure
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Receiver tests

Conformance Tests

Perform receiver conformance test

Overview This tests measures the receiver conformance.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters You may modify the following parameters for this test:

• Recall Calibration Settings

• Pause before starting RX tests

• Run ED Auto-Alignment before starting RX tests

• Target Error Ratio

• Target Error Ratio Confidence Level

• Error Detector Alignment Threshold

Type Test ID

200GBASE FR4 1100

200GBASE LR4 2100

200GBASE DR4 3100

400GBASE FR8 4100

400GBASE LR8 5100

400GBASE DR4 6100

400G-FR4 7100

100G-FR 14100

100G-LR 15100

100GBASE-DR 8100

50G-SR/100G-SR2/200G-SR4/400G-SR8 9100

100G-SR/200G-SR2/400G-SR4 16100

50G FR 12100

50G LR 13100
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• Recall Aggressor Channel

• Aggressor Channel Source

• Aggressor Channel Target

BERT Settings

• Pattern Generator Line Coding

• Pattern Generator Data Pattern

• Error Detector Line Coding

• Error Detector Data Pattern

• Error Detector Baud Rate

• Error Detector Follow SYS Clock

• Error Detector Compare Mode

• Error Detector Polarity

• Error Detector Timeout

• Error Detector (#1) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #1)

• Error Detector (#2) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #2)

• Clock Data Recovery Source

• Clock Data Recovery Loop Bandwidth

• DUT Control Interface Script File

• DUT Control Interface Location

• DUT Control Interface Address

Jitter Measurement Settings

• Jitter Tolerance Algorithm

• Receiver Test Settling Time

• Frequency Relax Time

• Amplitude Relax Time

• Jitter Tolerance CDR LBW Auto

• Frequency Grid Mode

• Frequency Increment Mode

• Start Frequency

• Stop Frequency

• Number of Steps

• Jitter Profile Frequency1

• Jitter Profile Amplitude1
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• Jitter Profile Frequency2

• Jitter Profile Amplitude2

• Jitter Profile Frequency3

• Jitter Profile Amplitude3

• Manual Frequency List

RX Sensitivity Measurement

• RX Sensitivity Test Power Start

• RX Sensitivity Test Power Stop

• RX Sensitivity Test Power Step

Procedure Refer to “Automated Compliance and Performance Tests” on page 54.

Results Pass/Fail

Perform jitter conformance test

Overview This tests measures the receiver jitter conformance.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID
Type Test ID

200GBASE FR4 1101

200GBASE LR4 2101

200GBASE DR4 3101

400GBASE FR8 4101

400GBASE LR8 5101

400GBASE DR4 6101

400G-FR4 7101

100G-FR 14101

100G-LR 15101

100GBASE-DR 8101

50G-SR/100G-SR2/200G-SR4/400G-SR8 9101
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Configuration Parameters You may modify the following parameters for this test:

• Recall Calibration Settings

• Pause before starting RX tests

• Run ED Auto-Alignment before starting RX tests

• Target Error Ratio

• Target Error Ratio Confidence Level

• Error Detector Alignment Threshold

• Recall Aggressor Channel

• Aggressor Channel Source

• Aggressor Channel Target

BERT Settings

• Pattern Generator Line Coding

• Pattern Generator Data Pattern

• Error Detector Line Coding

• Error Detector Data Pattern

• Error Detector Baud Rate

• Error Detector Follow SYS Clock

• Error Detector Compare Mode

• Error Detector Polarity

• Error Detector Timeout

• Error Detector (#1) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #1)

• Error Detector (#2) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #2)

• Clock Data Recovery Source

• Clock Data Recovery Loop Bandwidth

• DUT Control Interface Script File

• DUT Control Interface Location

• DUT Control Interface Address

100G-SR/200G-SR2/400G-SR4 16101

50G FR 12101

50G LR 13101

Type Test ID
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Jitter Measurement Settings

• Jitter Tolerance Algorithm

• Receiver Test Settling Time

• Frequency Relax Time

• Amplitude Relax Time

• Jitter Tolerance CDR LBW Auto

• Frequency Grid Mode

• Frequency Increment Mode

• Start Frequency

• Stop Frequency

• Number of Steps

• Jitter Profile Frequency1

• Jitter Profile Amplitude1

• Jitter Profile Frequency2

• Jitter Profile Amplitude2

• Jitter Profile Frequency3

• Jitter Profile Amplitude3

• Manual Frequency List

RX Sensitivity Measurement

• RX Sensitivity Test Power Start

• RX Sensitivity Test Power Stop

• RX Sensitivity Test Power Step

Procedure Refer to “Automated Compliance and Performance Tests” on page 54.

Results Pass/Fail

Performance Tests

Perform receiver sensitivity measurement

Overview This tests measures the receiver sensitivity.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.



Keysight N4917BSCB 400G Optical Receiver Test Application User Guide 105

Performing Stressed Receiver Compliance Tests with N4917BSCB Software 5

 

ID

Configuration Parameters You may modify the following parameters for this test:

• Recall Calibration Settings

• Pause before starting RX tests

• Run ED Auto-Alignment before starting RX tests

• Target Error Ratio

• Target Error Ratio Confidence Level

• Error Detector Alignment Threshold

• Recall Aggressor Channel

• Aggressor Channel Source

• Aggressor Channel Target

BERT Settings

• Pattern Generator Line Coding

• Pattern Generator Data Pattern

• Error Detector Line Coding

• Error Detector Data Pattern

Type Test ID

200GBASE FR4 1103

200GBASE LR4 2103

200GBASE DR4 3103

400GBASE FR8 4103

400GBASE LR8 5103

400GBASE DR4 6103

400G-FR4 7103

100G-FR 14103

100G-LR 15103

100GBASE-DR 8103

50G-SR/100G-SR2/200G-SR4/400G-SR8 9103

100G-SR/200G-SR2/400G-SR4 16103

50G FR 12103

50G LR 13103
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• Error Detector Baud Rate

• Error Detector Follow SYS Clock

• Error Detector Compare Mode

• Error Detector Polarity

• Error Detector Timeout

• Error Detector (#1) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #1)

• Error Detector (#2) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #2)

• Clock Data Recovery Source

• Clock Data Recovery Loop Bandwidth

• DUT Control Interface Script File

• DUT Control Interface Location

• DUT Control Interface Address

Jitter Measurement Settings

• Jitter Tolerance Algorithm

• Receiver Test Settling Time

• Frequency Relax Time

• Amplitude Relax Time

• Jitter Tolerance CDR LBW Auto

• Frequency Grid Mode

• Frequency Increment Mode

• Start Frequency

• Stop Frequency

• Number of Steps

• Jitter Profile Frequency1

• Jitter Profile Amplitude1

• Jitter Profile Frequency2

• Jitter Profile Amplitude2

• Jitter Profile Frequency3

• Jitter Profile Amplitude3

• Manual Frequency List

RX Sensitivity Measurement

• RX Sensitivity Test Power Start

• RX Sensitivity Test Power Stop
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• RX Sensitivity Test Power Step

Procedure Refer to “Automated Compliance and Performance Tests” on page 54.

Results Pass/Fail

Perform jitter performance measurement

Overview This tests measures the receiver jitter performance.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters You may modify the following parameters for this test:

• Recall Calibration Settings

• Pause before starting RX tests

• Run ED Auto-Alignment before starting RX tests

• Target Error Ratio

• Target Error Ratio Confidence Level

Type Test ID

200GBASE FR4 1102

200GBASE LR4 2102

200GBASE DR4 3102

400GBASE FR8 4102

400GBASE LR8 5102

400GBASE DR4 6102

400G-FR4 7102

100G-FR 14102

100G-LR 15102

100GBASE-DR 8102

50G-SR/100G-SR2/200G-SR4/400G-SR8 9102

100G-SR/200G-SR2/400G-SR4 16102

50G FR 12102

50G LR 13102
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• Error Detector Alignment Threshold

• Recall Aggressor Channel

• Aggressor Channel Source

• Aggressor Channel Target

BERT Settings

• Pattern Generator Line Coding

• Pattern Generator Data Pattern

• Error Detector Line Coding

• Error Detector Data Pattern

• Error Detector Baud Rate

• Error Detector Follow SYS Clock

• Error Detector Compare Mode

• Error Detector Polarity

• Error Detector Timeout

• Error Detector (#1) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #1)

• Error Detector (#2) Clock Source (CLK IN)

• Clock Data Recovery Module (ED #2)

• Clock Data Recovery Source

• Clock Data Recovery Loop Bandwidth

• DUT Control Interface Script File

• DUT Control Interface Location

• DUT Control Interface Address

Jitter Measurement Settings

• Jitter Tolerance Algorithm

• Receiver Test Settling Time

• Frequency Relax Time

• Amplitude Relax Time

• Jitter Tolerance CDR LBW Auto

• Frequency Grid Mode

• Frequency Increment Mode

• Start Frequency

• Stop Frequency

• Number of Steps

• Jitter Profile Frequency1
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• Jitter Profile Amplitude1

• Jitter Profile Frequency2

• Jitter Profile Amplitude2

• Jitter Profile Frequency3

• Jitter Profile Amplitude3

• Manual Frequency List

RX Sensitivity Measurement

• RX Sensitivity Test Power Start

• RX Sensitivity Test Power Stop

• RX Sensitivity Test Power Step

Procedure Refer to “Automated Compliance and Performance Tests” on page 54.

Results Pass/Fail
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Utility Functions

Measure PAM4 eye parameters

Overview This step measures the PAM4 eye parameters - TDECQ, OER, OOMA, 
AvgPower.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters You may modify the following parameter for this test:

• Optimize crossing after RefTX Recalibration

• Auxiliary Instrument VISA Address

• Auxiliary Instrument SCPI Command

Results Pass/Fail

Optimize BERT deemphasis

Overview This test performs a BERT deemphasis optimization.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8
100G-SR/200G-SR2/400G-SR4,
50GBASE-FR, 50GBASE-LR

10005
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ID

Configuration Parameters • Optimize crossing after RefTX recalibration

• Auxiliary Instrument VISA Address

• Auxiliary Instrument SCPI Command

Results Pass/Fail

Recalibrate Reference Transmitter

Overview This step recalibrates the reference transmitter.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters • Optimize crossing after RefTX recalibration

• Auxiliary Instrument VISA Address

• Auxiliary Instrument SCPI Command

Results Pass/Fail

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8, 
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10004

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8, 
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10000
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Readjust reference transmitter power

Overview This step readjusts the previously calibrated output power of the REFTX  
measured at the optical attenuator by means of fine-tuning the REFTX 
operating point.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters • Optimize crossing after RefTX recalibration

• Auxiliary Instrument VISA Address

• Auxiliary Instrument SCPI Command

Results Pass/Fail

Adjust Receive Power

Overview This step adjusts the receive power.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters • Optimize crossing after RefTX recalibration

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8, 
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10009

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8, 
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10001
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• Auxiliary Instrument VISA Address

• Auxiliary Instrument SCPI Command

Results Pass/Fail

Set laser wavelength

Overview This step sets the laser wavelength.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters • Optimize crossing after RefTX recalibration

• Auxiliary Instrument VISA Address

• Auxiliary Instrument SCPI Command

Results Pass/Fail

Set PG transmission format

Overview This step sets the line coding and transmission data pattern for the 
connected pattern generator.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8, 
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10003
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ID

Configuration Parameters • Pattern Generator Line Coding

• Pattern Generator Data Pattern

Results Pass/Fail

Set ED detection format

Overview This step sets the line coding and analysis data pattern for all connected 
error detectors.

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters • Error Detector Line Coding

• Error Detector Data Pattern

Results Pass/Fail

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8, 
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10006

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8, 
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10007
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Recall aggressor channel

Overview This step recalls the aggressor channel on BERT output channel 2 using 
the settings according to the configuration variable "Aggressor Channel 
Source".

Connection Diagram Connect the instruments as shown in “Setting Up and Preparing the 
Compliance Test Setup” on page 76.

ID

Configuration Parameters • Recall Aggressor Channel

• Aggressor Channel Source

• Aggressor Channel Target

Results Pass/Fail

Type Test ID

200GBASE FR4, 200GBASE LR4, 
200GBASE DR4, 400GBASE FR8, 
400GBASE LR8, 400GBASE DR4, 
400G-FR4, 100G-FR, 100G-LR, 
100GBASE-DR, 
50G-SR/100G-SR2/200G-SR4/400G-SR8,
100G-SR/200G-SR2/400G-SR4, 
50GBASE-FR, 50GBASE-LR

10008
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